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Dhaka Stock Exchange Ltd. (DSE) has implemented a Centralized Order Management System 

‘DSE-FlexTP’ for the TREC holders of the exchange to manage their orders. The introduction of 

this technology has bring a new dimension of business opportunities in the capital market, and 

it is exciting to see the exchange embracing state-of-the-art technology to improve trading 

efficiency. DSE-Mobile service is a platform of DSE-FlexTP by which investors of DSE can get real-

time market updates and as well as can trade (if TREC permitted). This is connected investors to 

the state‐of‐the‐art technology of trading. DSE‐Mobile service is being facilitate to bring new 

dimension of business opportunities in the capital market. 

 

DSE-Mobile service was introduced in March 2016 and has undergone regular updates to meet 

user needs and ensure compliance with security standards. The latest version, DSE-Mobile v2, 

was released in April 2023 with advanced feature and utilizes the latest development 

frameworks to optimize usability and improve the user experience.   The DSE-Mobile service 

provides real time Equities bid/ask quotes, Request for Streaming (RFS) trading capabilities, 

managing and monitoring resting orders in a secure mode, in synchronization with a Web HTML5 

app for dealers at office.  

 

There are two applications under DSE-Mobile service as follows: 

 

1. DSE-Mobile (APP): The DSE-Mobile (App) is mobile application (APP) which provides real 

time Equities bid/ask quotes, Request for Streaming (RFS) trading capabilities, managing 

and monitoring resting orders in a secure mode, in synchronization with trader-dealer 

terminal. DSE-Mobile is a native mobile application for iOS and Android phones. DSE-

Mobile (APP) has following versions: 

 

 DSE‐Mobile VIP – Allows you to be aware of your portfolio and favorites without efforts, 

keep in touch with professional trader to get high‐end services. Trader will professionally 

manage best execution of your orders. 

 

 DSE‐Mobile Trader – Allows you to be aware of your portfolio and favorites without 

efforts, keep in touch with professional trader to get high‐end services while availing 

ability to manage orders yourself. 

 DSE‐Mobile Biz Owner – Allows business owner to be aware of activities of their broking 

business status. This is only for dealer account (Type D) of TREC holder. 

 

2. DSE-Investor: It’s an application which can run on any HTML-5 compatible browser. It 

can access from PC, Laptop, TAB through HTML-5 compatible browser like Google 

chrome, Firefox, Safari, Edge etc. 

1. Introduction  
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1.1. Features DSE-Investors 
 

This application is similar the trader terminal of a TREC but for the individual only. Main 
features available in DSE-Investor are: 

 

 Real time market information and indicative bid/ask prices; 

 Intuitive navigation menu; 

 Customized favorite lists; 

 Securities Listed in Different Indices (DSEX, DS30, DSMEX and ATBX); 

 Historical and intraday Charts with technical indicators; 

 Placement of instant orders via PODs; 

 Placement of single leg LIMIT resting orders; 

 Portfolio management with Real‐time P&L; 

 Tracking of executions; 

 Order Blotter Filters; 

 Biometric Authentication; 

 Self-password reset and device un-register; 

 

DSE‐FlexTP System ‐ Information in this manual is general in nature. We recommend to seek 
independent financial advice and ensure you fully understand the risks involved before trading. 
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2. Pre-Requisite 

To access the DSE-Investor application, you should have User-ID, Password and 2FA (Two Factor 

Authentication) code.  

You should apply in prescribed form to your TREC to get DSE-Mobile service. According to your 

application the TRE will complete registration process in the system and you will get User-

ID/Login-ID and system generated password. 

2.1. Install DSE‐Mobile APP 
 
To get the 2FA, you need to install the DSE-Mobile App in your mobile device. Contact your TRECs 

(Broker) for registration and subscription for DSE-Mobile service. 

 Once your login has been created by your TREC (Broker), you will receive your credentials 

(login/password) by email and respective links. 

 Click on the download link of the email, or search for “DSE Mobile” in the Google Play 

Store or Apple App Store. 

 Select the app and click on “Install” 

 
TIPS: The app might prompt you to update it from time to time, although in most cases your 
phone will update it automatically. This is to ensure that you access all the latest features that 
are published.  
 

Device Compatibility - Minimum requirements for the DSE‐Mobile App: 
 

 Android Device: Minimum version of Android is 11 to get optimum features and all 

functionalities of DSE-Mobile. But user can install the App on Android 8.1 or later version 

subject to support by the Google Play. 

 iOS Device: Minimum version of iOS is 13 to get optimum features and all functionalities 

of DSE-Mobile. But user can install the App on iOS 12 subject to support by the Apple App 

Store. 

 Phone viewport size (screen resolution): over 350px 

 Internet data connectivity: 4G or Wi‐Fi 

 

2.2. Device Registration  
  

 Click on the DSE-Mobile icon installed on your device Home screen. 

 The login screen prompts you to enter your Username and Password.  
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Login and password are 

provided by your TREC 

through email. 

 

Please contact your TREC 

IT desk for blocked 

access. 

 

Click on “Forgot 

Password” to reset your 

password. 

 

Figure - the Login page 

On the first login it will ask for change the password and register your device. Do these tasks 

to complete the process. 

 

 

 

 

 

 

 

 

 

Figure – password change      Figure – device registration 
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3. Accessing DSE-Investor 

Once completed necessary tasks (section-2) you can access the DSE-Investor 

3.1. Log-in to DSE-Investor  
 

You should use HTML-5 compatible browser (like Google chrome, Firefox, Safari, Edge etc.) in 

your device PC, Laptop, TAB and browser should be updated. The minimum version of 

browsers as follows: 

Browse Latest Version* Min. Recommended Version 

Chrome 114.0.5735.134 102.0.0 

Edge 114.0.1823.67 101.0.0 

Firefox 114.0.2 101.0.0 

Safari 16.0.0 13.0.0 

 

* As on June 2023. 

 Open a Browser and launch the DSE-Investor link: https://minvest.dsetrade.com  

 Put your Login-ID in the opening screen and click on next 

 

  

https://minvest.dsetrade.com/
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 Put your password in the next screen and click on “Log In” 

  

Click on “Forgot Password” to reset your password  

 

 It will ask for OTM (One Time Password) as part of 2FA. 

 Open the DSE-Mobile APP in your mobile device to get the OTP. 

 Put the OPT (Security Code) and click Verify to complete login process. 

 

 

  



 

Page 11                                                          Version v1.1 – July 2023 

 

DSE Investor User Guide 

 

3.2. Home Page 
Once you logged in, the landing page will be follows: 

 

Tips: To get optimum performance of real-time market information, you should ensure good 
quality of internet connection or network connectivity. 
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4. Operation of DSE-Investor 

 This section of the User Guide describes the following operational aspects of the DSE-
Investor application: 

 The Interface Layout 
 The Main Access Menu 
 Pages 
 Connection Data 
 The Tab Bar 
 The Component Title Bar 
 Contextual Menus 

 

4.1. The Home Page Layout 
The DSE-Investor home page have the following tools and features. 

- The Main Access Menu 

- Workspaces 

- Tabs 

- Pages 

- Market Statistics 

- Ribbon 

- Connection Indicator 

- Component Contextual Menu 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the respective tools or feature for the relevant activities. 

4.2. The Main Access Menu 
 
The Main Access Menu gives access to key features such as saving, loading pages, changes 
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password and log out. To open the Main Access Menu, click on the DSE icon in the top-left 
hand corner of the window. 
 
 
 
 
 
 
 
 
There are three tabs under the Main Menu as follows: 
Pages  
My Profile 
EMS 

 

4.2.1 Pages 

The items in the pages are as follows: 

Menu Item 
 

Description 

Edit Click to create to edit page 

Save Click to save changes done on current pages. 

Save As Click to create a new page based on the current page template 

Load previous save Click to reload the previously saved state. 

Reload Click to return to original settings and reset all saved states.  

* All option may not available right now 

4.2.2 My Profile 

Following features are available under My Profile: 

 User   – The account number of the investor; 

 Profile   – Profile name; 

 Session  – Click “Logout” form the DSE-Investor. The session timeout is 30 

minutes; 

 Password  – Click “Password” to change the password. It’s mandatory to change the 

  password in every 30 days; 

 Theme  – Changing the current theme of the DSE-Investor. There are three 

  different themes for user choice i.e. Dark, Light and Light Purple;  

 Enable Trace  – For debugging purpose; 
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4.2.3 EMS 
There different parameter for Order/Execution Management (EMS). User can set desired value or 

remain blank. 

 Order Type  – There are three different order types 

o Limit – Order in price specific; 

o Marker – Order in Market Price; 

o Marker At Best – Order in Market Price; 

 Bid/Ask Side  – Define Bid as Buy or Sell; 

 Default Qty  – To set default quantity for an order; 

 Qty Increment  – To set value to increase/decrease order quantity on a click. 

 

4.3. Connection Indicator 
Below the Market Status is a clock that represents the trading and market data connections. There are 3 

connection statuses which are represented by 3 colors. When you point your mouse over the clock, a 

tooltip appears which shows you the connection status details: 

Color What it Means What the Tooltip May Show 

Green Trading and market data are 
connected 
 

 
 

  
Orange/Amber Either OMS or FIX (or both) 

connection is (are) down 
 

 
 

 
Red Market data connection is down 
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4.4. Market statistics:  
User wish to select Indices DSEX, DS30, DSMEX or ATBX and can view Last value of Index, Net% change, 

Market turnover, Value, Total trades, Securities Ups, Downs and Unchanged  

 

4.5. Workspaces and Pages 

Your basic working environments are divided into two related elements: Workspaces and Pages. 

4.5.1 Workspaces 

 
Workspaces are a selection of either pre-defined layout which cannot be altered or sections that you 

create yourself. They are organized as a drop-down list, each containing an associated set of pages. 

The application offers two workspaces accessible from the drop-down list next to the logo: 

 DSE 

 Responsive 

 

 DSE workspace 

 

This workspace contains pages that have been designed as default pages for all users and cannot be 

altered. The content and layout of the page are pre-defined and cannot be modified. 

 Responsive workspace 
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This workspace contains pages that have been designed as default pages for all users and cannot be 

altered. The content of the page can be customized but the layout is pre-defined and cannot be modified. 

Responsive workspace is following the responsive design concept. All components will adapt 

automatically to maximize and optimize the display to the size of the screen allowing users to use M-

Invest on a tablet for example. 

4.5.2 Pages 
 

The Page is your immediate working environment and is made up of your personal selection of 

components. The pages are presented as a list of personally selected icons at the top of the screen. You 

can create a maximum of twelve pages in this Workspace. 

DSE-Investor is designed with 10 pre-defined pages under the DSE workspace: 

 

Page 
 

Components Description 

Account 
 

Execution, My Reports, Alerts, Logout and Change Password 

Analytics Chart, POD, Day% Treemap, Day% Pie, Sector Treemap, Sectors Pie 

ATB Watchlist, Chart, Market Depth, Score Board of ATB Board 

ClntNet Watchlist, Visualization Trading, Order Summary, Orders and Execution 

Main Watchlist, Chart, Market depth and News 

MktStat Chart, DSE Indices, Score Board of Main Board, Gainers, Losers and Active 
security 

SCP Watchlist, Chart, Market depth and Score Board of SCP Board 

Trading Watchlist, Cash/Credit Limit, Position, POD, Ticket, Order, Execution 

Ticker Rolling Ticker or Market Ticker on DS30 securities only 

Notifications Timeline of trading event 

 

4.6. Tabs 
 

The Tab Bar is situated at the top of the screen beneath the Ribbon. This tool enables you to add 

additional views to a pre-defined page model, thus ensuring that you can quickly view large quantities of 

data. 

The Page component layout will always be identical, but you can change the data that is displayed in the 

components and make it unique to each shortcut if required. You may for example want to use this tool 

to display different list of instruments and call them quickly or to display graphs for many different 

instruments in a page.  

The Tab Bar is specific to each page.  
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To create a new tab, click the Add Tab option. This opens the New panel window. 

 

Type the Tab name and Click OK to create the new tab that will appears immediately in the Tab bar.  

Note: Make sure that you save a Page to ensure that the tabs you have created remain linked to the 

page. 

To configure one of the tabs, right-click on the tab name. This displays the following contextual menu.  

 

The menu items are as follows: 

Menu item Description 

Open Open the page corresponding to the icon you clicked on. 

Delete Enables you to remove the selected tab shortcut. 

Save Component To add a new component configuration to the existing tab. 

Change Title Change the name of the Tab. 

Example: Create 2 tabs to display quickly Majors and Precious watchlists. 

1- Open the Watchlist browser and click on Group A in the Main Board of the Constituent section 
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2- The Watchlist now displays Group A instruments 

3- Click “Add tab” and name as “Group A” 

To create the Group B watchlist: 

4- Open Watchlist browser and Click on Purge Watch list. 

5- Expand the Dhaka SE constituent list by clicking on the white arrow. 

6- Click Main Board, Groups, then Group B to add to the composite watchlist. 

7- Click “Add tab” and name as “Group B” 

Upon clicking on the “Group A” or “Group B” tabs, instruments will be displayed in the watchlist 

accordingly. 

 

4.7. Component Contextual Menus 
 

Almost every component contains a contextual menu. This menu is displayed when you right-click on an 

instrument in the component. The instrument name is displayed at the top of the menu, then the menu 

is divided into two or three sections: Trading and Market Data. All selected options in this menu open in 

a separate pop-up window. 

 

Most of the menu items are available in each component, but certain items, such as trading instructions, 

or the Specific section are only available from certain components at certain times. 

4.8. Standard Components 
 

4.8.1 Keyboard Shortcuts 
 

Press Ctrl + F1 to display the list of keyboard shortcuts: 
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4.8.2 Watchlist & Favorite lists 

The Watch List displays live market data for instruments or groups of favorites that you choose to create 
and display. 

 
You can also trade from this component or display charts and market depth by right-clicking on the 
instrument and choosing the relevant option in the contextual menu. 

Work with the Watch List component by using the following two configuration features: 

- The Watch List Browser 
- The Watch List Shortcuts 
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4.8.2.1 The Watchlist Browser 

Each component has a unique Browser which features a selection of sections which enable you to 

configure the component layout, search for instruments and change display elements. The Watch List 

Browser enables you to perform the following tasks: 

- Search for individual instruments. 
- Add, change, or remove data elements. 
- Add or remove columns. 
- Change display options. 

 

Data 

The Data section gives rapid access to instrument and enables you to create and save your own lists of 
instruments. It also gives access to more advanced searches. 

This section is divided into three sub-sections: 

- Last Instruments: displays the most recently loaded instruments or indices. Click Search other 
instruments... to launch the Advanced Search window. 

- User list: enables you to create favorites. 

- Select constituents displays the full list of available instruments. 

 
 

4.8.2.2 Watchlist Shortcut 

The shortcuts box is a selection of tabbed sections with text entry fields, search options and action 

buttons. The principal role of the shortcuts tool is to enable you to perform simple tasks or change 

configuration elements in one click. 
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To open the Shortcuts Box, click on the Configure icon in the title bar. The Watch List Shortcuts Box is 
divided into three tabs: 

 View 

 Favorite 

 Display 

 
 

Selecting required option generally performs the associated action immediately. 

View 

The shortcut choices are as follows: 

Shortcut 
 

Description 

Var% 
 

Displays the list with the emphasis on the instrument position percentage 
change. 

Bid Ask Displays the list with the emphasis on the bid and ask positions. The bid 
ask view displays the best offer demand prices and quantities, the last 
price and the time. 

Wide Bid/Ask Displays the list with the emphasis on the bid and ask positions 

Performance Displays a performance view, with the evolution of the value over one 
day, one week, one month and three months. 

Volume Displays a volume view. The Volume view makes it possible to estimate 
the volume of the last two trading sessions in terms of the average daily 
volume over the last week. 

Pre-Open Displays the pre-open view. The Pre-Open view displays the margin and 
the MBA (Mid Bid Ask), making it possible to anticipate the likely opening 
price 

OHLC Displays the Open, High, Low and Close as well as the last price and day 
percentage. This is the default display for the Watch List component. 

 

Favourite 

The Favourite tab enables you to display your previously configured instrument lists and column 

configurations. 
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Shortcut 
 

Description 

Favourite 1-3 Displays your previously saved list of instruments, known as favourites. 
See the Creating your own instrument lists section for more details on this 
feature. 

 

Display 

The Display tab enables you to configure certain display options in the Watch List. 

 

 
 

Shortcut 
 

Description 

Custom order Sort the watchlist in the order it was created. 

Flashing Enables or disables quote flashing. Quote flashing is the process of 
highlighting instrument data each time there is a trade and a movement in 
the price or quantity. This option is enabled by default. 

Font Size Increases or decreases the text size in the Watch List component. 

Directions Displays a green or red arrow next to the last price, showing the last trade 
direction of the instrument. 

Flags Displays the country flag relating to the exchange on which the instrument 
is quoted. 

 

4.8.3 Creating your Favorites Instrument Lists 

When you first open a session, by default the Watch List components are populated with lists of pre-
defined lists. You can however create your own personal lists of instruments, known as Favorites, and 
store these for future retrieval. 

To method to retrieve pre-defined watchlists is the following: 

 

1. Click the Watchlist Browser icon 
2. Select the Data tab. 
3. Expand the Constituents section, select Dhaka SE, Main Board and Groups and click one of the 

lists displayed: 
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4. The Group A list of instruments is displayed: 

 

The method for the creation of favorites is the following: 

1. Click the Browser icon. 

 

 

2. Select the Data tab. 
3. Click Purge Watch list to empty the Watch List component: 

 

4. A composite watchlist is opened allowing you to add instruments from all constituents. 

 
 

5. Using the Intelligent search feature of the composite Watchlist, you can add instruments to your 
list. 
The Intelligent Search feature is situated in the command box at the top of the component. As 
you type a string of letters, a box appears displaying the 10 most frequently accessed instruments 
that correspond to the string.  
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6. Click on one of these if it corresponds to the instrument you require to load into the component. 
You can also use the arrow keys on your keyboard to navigate between instruments, then select 
an instrument by clicking enter.  

7. Once this is completed you can then type another instrument string, meaning that you can enter 
a series of instruments into the Watch List just by using your keyboard. 

 
 

Last instruments added is displayed on top of the Composite watchlist. You can change the order of each 
instruments in the list using drag and drop: 

 

 

8. From the composite list, you can add instrument to a Favorite list using the Favorite Icon  

by right click. 
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9. Save the Page to retrieve your composite watchlist at a later stage. 
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5. Portfolio Overview 

You can view your cash and matured security by the following way: 

 

5.1. Cash 
Switch your page to Trading page and can view cash and intraday cash. Cash means the back office 

matured balance which uploaded in the system and intraday means you sold share in the day which 

balance. You can buy share from cash and intraday cash as per the rules. 

 

5.2. Position 
Your matured share to be viewed in the position page which uploaded in the system. You can sell share 

in the day. 

 

5.2.1 Position Blotter 

 
The Position Blotter component provides a list of instruments in your portfolio that you have created. 
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Contextual Menu allows to take actions on each position. To open the contextual menu, right-click on 
any position under the Trading page to open the following menu and take actions: 

 
 

5.2.2 Position Blotter Browser  

 

The Position Blotter Browser enables you to perform the following tasks:  
 Add an Aggregation line on top of the component. 
 Change columns.  

 

5.2.3 Position Blotter Tools  

 

The Position Blotter offers different visualization options for the client’s positions: 
- Profile Day% Treemap 
- Profile Day% Pie 
- Profit/Loss Treemap 
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Example of Positions visualization: 

- Day% - Today Day Change % 

- Volume - Today Volume 

- Last - Today Last 

- Size -  (Today Volume * Today Last) 

- Share - percentage of the size of the Tree Map 

 

 

 

 

 

 

 

 Trading 
You can submit an order Buy/Sell from watchlist, Portfolio or Chart option. Right click in watchlist of any 

of your desired security and open a pop menu. You can select Buy/Sell from this option or press F1/F2 

from keyboard and open buy/sell ticket. Then put qty, price and send buy. 

6.1. Order Ticket 
To open the order ticket, you must first select an instrument from the watch list or search for it using the 

search box. On the right panel, where the selected (or searched) ticker’s details are displayed, you will 

see the [Buy] and [Sell] buttons. Upon clicking either of the buttons, the order entry ticket opens in a 

modal window.  

The new ticket displays market context with Depth and Times and sales. 
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The following are fields in the order input part: 

Field Description 

Instrument Ticker code and name 

Account Your account name 

Type Order Type 

Quantity Enter the number of shares you want to trade on here 

Limit Contains the default price per share but you can change this 

Value Automatically shows the total cost of the transaction as you input the Quantity 
and/or price 

Validity Selection box for the trade validity type. By default, it shows ‘Day’ but you may 
select another choice from the list if available. 
 

  

  

 

6.1.1 Place an Order:  
Place order from order ticket or from watchlist right click of your desired security or press F1/F2 buy or 

sell and preview and place order for final submission. 

 

 

 

 

 

 

 

 

 

 

 

Enter the quantity. The keyboard or the pre-defined buttons can be used. 

By default, an order is at Limit price and with Day validity.  

Click on the [PREVIEW ORDER SELL] to view the order summary. 
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To change the order details, click on the [BACK] button.  

If you confirm that the order details are correct, then click the [PLACE ORDER] button if you want to 

send the order immediately. 

You will now see the order you placed in the Working Orders panel under Blotter.  

6.1.2 Modify a Working Order 
User allows to modify working orders. From the Blotter, open the contextual menu and select “Modify” 

or press F4. 

The modify ticket opens and allows to update the following information: 

- Quantity 

- Price 

 

6.1.3 Cancel a Working Order 
You may cancel an order that has not been filled yet or has only been partially filled. Select the order 

from the Working Orders panel and in the displayed details, click on the [CANCEL ORDER] button or 

press F10.  

A confirmation message will be prompted.  

 

To proceed with the cancellation, click on [CONFIRM]. The order will be cancelled immediately and will 

appear under the Executed Orders panel as canceled.  
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6.2. Order Blotter 
The Blotter monitors the execution status of your orders in real-time. It can display pre-defined and 

customized views, offering a combination of execution and market data information using a selection of 

the available columns. 

 

 

6.3.1 Blotter Browser 

 

 

The Blotter browser enables you to perform the following tasks: 

- Add or remove columns. 
- Add and define filters. 
- Change the component type, the link details, or the name of the chosen component. 

Columns 

The Columns section enables you to create a personalized data display view by choosing the data 
columns that are most relevant to you 
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6.3.2 Blotter Shortcuts Tools 
 

 

The Shortcuts tool offers a selection of shortcut icons that enable you to rapidly perform several 
organization and display actions. These are described in the table below. 

 

The shortcut choices are as follows: 

Shortcut Description 

 To filter by side: Buy / Sell 

 To filter by Dealers 

 To filter by source of the order (ET2 or Deal Online platform WEB or Mobile) 

 
To filter by validity (Day, FOK, GTC, GTD, custom date 

 To display by Parent/Child 

 
To filter by ET2 order state (Activated / Deactivated) 

 To filter by Order status (Terminated, Working, Filled) 

 To search an Order ID 

 

6.3.3 Order Status 
Each order under either Working or Executed Orders is represented by a symbol. The following symbols 

are used. 

Symbol Meaning 

 
New or Partially filled 

 
Filled 

 
Canceled or Rejected 

 
Replaced 

 
Parked 

 
Pending 

 

6.3.4 Order Details 
To display order details, use the right click contextual menu and click: Show 
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6.3. Duplicate Order and Duplicate Ticket 
You can send order quickly from order blotter by Duplicate order and Duplicate Ticket option 

Duplicate Order: Order will be sent instantly. There is no preview or option to modify. 

 

 Duplicate Ticket: You can view and may modify the order before submission 

 

 

6.4. Trade from Chart 
You can trade from security chart. Right click in the chart view and open Buy/Sell or POD ticket. 
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 POD Trading 
Trade in 2 clicks on the Bid or Ask. First unlock indicative and on Bid price or Ask price as the following 

screen. Condition is that it should have touchline price of that security. Following screen clear you the 

the POD trading. 
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 Execution  
The account page is where you can view your account details and activity, view dealer information and 

logout. 

 

On the left panel, you can view a list of your past executions for reference. You are provided with some 

filter tools on top of the list window.  

 

8.1. Select Order Side 
To view specific order side, click on the Setting wheel and select a side (or all sides). 
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Figure 1 Selecting a Side Filter 

8.2. Select a Date or Period 
To specify a duration, click on the Execution Date dropdown to select the period type. 

 

 1 week – the date field will be disabled and will display the current date. This means that the 

executions from 1 week before the current date shall be displayed. 

 

 2 weeks - the date field will be disabled and will display the current date. This means that the 

executions from 2 weeks before the current date shall be displayed.  

 

 Report 
From your account page, you have the capability to generate trade reports in both PDF and Excel 

formats. These reports come in various pre-defined types to cater to your specific needs and can be 

stored for future reference. 
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 Chart 

The Chart component provides a series of graphical analysis mechanisms which vary in their complexity 
and sophistication, and which have been conceived to suit the specific needs of each individual analyst. 
There are several ways to manipulate the data in a Chart component. It also offers a selection of tools 
which enable you to insert pointers, lines and comments, or redefine the indicator display mode. You can 
also choose the time scales which suit you and zoom in and out on specific zones. 
 
Additionally, the new chart component offers trading capability, by either sending instant orders at the 
best bid/offer using the POD. 

Work with the Chart component by using the following configuration features: 

 The Chart Browser 

 The Chart Shortcuts 

 

There are several ways to display instrument data in a chart. You can: 
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- Type the name of the instrument in the Chart component command box. 
- Search for an instrument using the Browser. 

- Right-Click on the relevant instrument in a Watch List 

10.1. Capturing the Chart Component 

You can capture the data displayed in the Chart component in several different ways. 

Click anywhere in the chart to see a snapshot of the market data at that moment. Two lines representing 
the x/y axis are displayed and a pop-up box shows a selection of data corresponding to the position at 
the time or date (intersecting point). Keep your finger on the mouse button and sweep across the chart 
to see other positions. 

 

The data contained in the box is as follows: 

- Date and Time. If the chart is configured to show daily positions or greater, the time will always 
be displayed as 00.00. 

- The price at the intersecting point. 
- The Opening (O), High (H), Low (L) and Closing (C) prices at the instrument position in the chart 

that corresponds to the intersecting point. 

Note: This information may vary, depending on the type of chart you select and the timescale. 

You can click on the instrument position bars or candlesticks to display a series of black squares showing 
that the data has been selected. 

To move the x/y axis positions, position your cursor over the relevant zone. The cursor is now displayed 
as a hand. 

 

Click at the position you wish to move.  
You can now move the positions up or down or left or right. Click again to conserve the new position. 

Double-click to reset the scale. 
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10.2. The Chart Browser 
 

 

The Chart Browser enables you to perform the following tasks: 

- Add and define data filters. 
- Change display options 
- Change the component type, the link details or the name of the chosen component. 

Data 

The Data section offers rapid access to indices and gives access to the Advanced Search tool. 
This section is divided into two sub-sections: 

- Last Instruments: displays the most recently loaded instruments or indices. Click Search other 
instruments... to launch the advanced search window. 

- Select constituents displays the full list of available instruments. 

 
 

10.3. The Chart Shortcuts 
 

 

To open the Chart Shortcuts Box, click on the configure icon in the title bar. 
The Chart Shortcuts Box is divided into four tabs, with a fifth available for certain technical settings: 

- Overlay 
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- Draw 
- Fibo 
- Display 
- Parameters 

Overlay 

The Overlay tab enables you to display a selection of indicator lines in the Chart component. 

 

The shortcut choices are as follows: 

Shortcut 
 

Description 

RSI Displays RSI indicators at the bottom of the Chart. 

ROC Roc Displays ROC indicators at the bottom of the Chart. 

Indicator 1-3 Indicator 1/2/3 Enables you to display a series of indicators, including 
volume, volatility and change percentages. 

SlowSTO Sto Displays stochastic indicators at the bottom of the Chart. 

Volume Vol Displays a volume bar chart at the bottom of the window. 

MA MA Displays Moving Averages indicators in the Chart. 

MACD Mac Displays MAC indicators at the bottom of the Chart. 

DMI DMI Displays DMI indicators at the bottom of the Chart. 

Bollinger Bol Displays Bollinger Bands in the Chart. 

Period Enables you to define the individual time plot sizes in the chart, from one 
minute to one year. 

Draw 

The Draw tab enables you to insert lines and text to the Chart component. 
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The shortcut choices are as follows: 

Shortcut 
 

Description 

Title Enables you to add titles in bold in the chart. 

Segment Enables you to draw a segment in the chart. The segment line remains the 
length you initially define. 

Arrow Enables you to draw arrows in the chart. 

Comment Enables you to write short comments in the chart. 

Parallel Enables you to draw parallel lines in the chart. First select the line, 
segment or arrow you wish to add (two small squares appear where the 
element is anchored) then click on this icon and finally click the position in 
the graph where you wish to add the parallel line. 

Paragraph Enables you to write longer comments in the chart. 

Line Enables you to draw an infinite line in the chart. This is useful for 
displaying mid and long term analysis of support and resistance. 

Horizon DMI Displays DMI indicators at the bottom of the Chart. 

Delete Enables you to remove a specific lines and text. 

Delete all Enables you to remove previously inserted lines and text. 

Fibo 

The Fibo tab enables you to add targets in the chart. 

 
 

The shortcut choices are as follows: 

Shortcut 
 

Description 

Price target Enables you to determine high and low targets using Fibonacci ratios in 
terms of price. 

Price retracement Enables you to calculate targets using retracement Fibonacci ratios in 
terms of price. 

Gann fan Displays Gann lines. 

Time target Enables you to determine high and low targets using Fibonacci ratios in 
terms of time. 

Time retracement Enables you to calculate targets using retracement Fibonacci ratios in 
terms of time. 

 

Cycle Displays Gann cycles. 

Elliptic target Enables you to determine the elliptical using both time and price Fibonacci 
ratios. 

Elliptic retracement Enables you to calculate targets using elliptical retracement Fibonacci 
ratios in terms of time and price. 
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Display 

The Display tab enables you to change display options in the chart. 

 

The shortcut choices are as follows: 

Shortcut 
 

Description 

Min max Displays two lines, showing the minimum and maximum price levels for 
the instrument over the given time period. 

 

Zoom Click on the arrows to zoom in and out 

 Enables you to change the way the data is displayed in the chart, for 
example as in Barchart, Candlestick or Close mode. 

Spectrum Displays the spectrum view on the right-hand side of the chart. The 
spectrum displays the volumes in terms of quotation levels instead of 
time. You can use this display to determine support or resistance levels. 

 Enables you to choose a display scale for the chart. This can be one of the 
followin:; Std scale, Base1000, %Var, Log. 

 

Print Print Enables you to print the chart graphics. 

Apply to all Applies the currently selected configuration elements to all open Chart 
components. 

Legend Displays a legend at the top of the chart, outlining the instrument, dates 
and times and other additional added elements. 

 Enables you to define the individual time plot sizes in the chart, from one 
minute to one year. 

Enables you to define the individual time plot sizes in the chart, from one minute to one year. 

10.4. Compare Chart 

The Compare Chart component enables you to compare up to five different values in one chart. There 
are several ways to manipulate the data in a Compare Chart component. It also offers a selection of tools 
which enable you to insert pointers, lines, and comments, or redefine the indicator display mode. You 
can also choose the time scales which suit you and zoom in and out on specific zones. 

To configure this component, use the Browser and Shortcuts windows. 
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There are several ways to display instrument data in the Compare Chart. You can: 

 Type the name of the instrument in the Compare Chart command boxes. 

 Search for a particular instrument using the Browser. 

 Drag and drop an instrument from a Watch List to a Compare Chart component. 

 Click on the relevant instrument in a Watch List if the Watch List is defined as being linked to 
the Compare Chart component. 

Note: Before inserting instruments, you should first choose the number of instruments you wish to insert 
from the drop-down list in the title bar. 

10.5. Customizing the Chart Component 

You can customize the data displayed in the Compare Chart component in several different ways. Click 
anywhere in the chart to see a snapshot of the market data at that particular moment. Two lines 
representing the x/y axis are displayed and a pop-up box shows a selection of data corresponding to the 
position at the particular time or date (intersecting point). Keep your finger on the mouse button and 
sweep across the chart to see other positions. 

 

The data contained in the box is as follows: 

 The date at the intersecting point. 

 The price at the intersecting point. 

 The price for each of the instruments in the chart corresponding to the intersecting point. 
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You can click on the progression line to display a series of black squares showing that the data has been 
selected. Right-click on any of the boxes to display a contextual menu. 

 

Click the Parameters option to open the Parameters section of the Shortcuts Box. This enables you to 
change the size, colour and format of the line in the chart. This also applies to any of the chart editing 
shortcuts that you add to the chart. 

 
To move the x/y axis positions, position your cursor over the relevant zone. The cursor is now displayed 
as a hand. 

 

 

Click at the position you wish to move. 

 

 

You can now move the positions up or down or left or right. Click again to conserve the new position. 

  



 

Page 45                                                          Version v1.1 – July 2023 

 

DSE Investor User Guide 

 

10.6. Compare Chart Tools 

To open the Compare Chart tools window, click on the configure icon in the title bar. 
The Compare Chart tools window is divided into four tabs, with a fifth available for certain 
manipulations: 

 Overlay 

 Draw 

 Fibo 

 Display 

 Parameters 

Overlay 
The Overlay tab enables you to display a selection of indicator lines in the Compare Chart component. 

 

Draw 
The Draw tab enables you to insert lines and text to the Compare Chart component. 

 

The shortcut choices are as follows: 

Shortcut 
 

Description 

Title Enables you to add titles in bold in the chart. 

Segment Enables you to draw a segment in the chart. The segment line remains the 
length you initially define. 

Arrow Enables you to draw arrows in the chart. 

Comment Enables you to write short comments in the chart. 

Parallel Enables you to draw parallel lines in the chart. First select the line, 
segment or arrow you wish to add (two small squares appear where the 
element is anchored) then click on this icon and finally click the position in 
the graph where you wish to add the parallel line. 

Paragraph Enables you to write longer comments in the chart. 

Line Enables you to draw an infinite line in the chart. This is useful for 
displaying mid and long term analysis of support and resistance. 

Horizon DMI Displays DMI indicators at the bottom of the Chart. 
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Delete Enables you to remove a specific lines and text. 

Delete all Enables you to remove previously inserted lines and text. 

Fibo 
The Fibo tab enables you to add targets in the chart. 

 

The shortcut choices are as follows: 

Shortcut 
 

Description 

Price target Enables you to determine high and low targets using Fibonacci ratios in 
terms of price. 

Price retracement Enables you to calculate targets using retracement Fibonacci ratios in 
terms of price. 

Gann fan Displays Gann lines. 

Time target Enables you to determine high and low targets using Fibonacci ratios in 
terms of time. 

Time retracement Enables you to calculate targets using retracement Fibonacci ratios in 
terms of time. 

 

Cycle Displays Gann cycles. 

Elliptic target Enables you to determine the elliptical using both time and price Fibonacci 
ratios. 

Elliptic retracement Enables you to calculate targets using elliptical retracement Fibonacci 
ratios in terms of time and price. 

 

Display 

The Display tab enables you to change display options in the chart. 
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The shortcut choices are as follows: 

Shortcut 
 

Description 

Zoom Click on the arrows to zoom in and out 

 Enables you to change the way the data is displayed in the chart, for 
example as in Barchart, Candlestick or Close mode. 

 Enables you to choose a display scale for the chart. This can be one of the 
followin:; Std scale, Base1000, %Var, Log. 

 

Print Print Enables you to print the chart graphics. 

Legend Displays a legend at the top of the chart, outlining the instrument, dates 
and times and other additional added elements. 

 Enables you to define the individual time plot sizes in the chart, from one 
minute to one year. 

Export Enables you to export a chart to Microsoft Word, to send the chart via e-
mail or to save the chart in .gif format. 

Parameters 
If you select a line in a chart then right-click and select Properties, a Shortcut Box appears with the 
Display section being replaced by a Parameters section. 

 

 

The shortcut choices are as follows: 

Shortcut 
 

Description 

 
Enables you to change the color of displayed item. 

 
Enables you to change the thickness of the chosen line, from 1pt to 5pt. 

 

 Time and Sales:  

User can view Times and Sales of a Security/Index securities/ Group securities by right click of that 

securities or creating a T&S page. 

 

Following three types of time and sales available 

a) Time and Sales –Main 

b) T&S- History 

c) T&S- Business Done 
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 Notifications: 
Execution, Price alert, Portfolio alert be available in the notification page. 

 

 

The Notifications page is where you can view pertinent messages about tickers and orders when certain 

events occur. The messages are displayed as follows: 

 Left icon that’s related to the topic 

 Subject of the message 

 Time when the message is issued 

 Market Ticker:  
User can enable ticker by clicking ticker tab on the top of the workspace. DS30 Index securities trades 

showing in this ticker. If user disable ticker then just click on the ticker. 

 

 

 Session Timeout 
When you are logged-in to DSE Investor platform but have been idle for quite some time, a session 

timeout warning message will be displayed. 
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Click on [CONTINUE] to cancel the time counter and return to your session. Otherwise, click [END NOW] 

or do nothing within the 30-second time frame to be logged-out automatically from DSE Investor. 

 Theme change 
There three types of theme available. You may change theme by your choice in the following way: 
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16.1. Reset Password 
 

In case of forgot password, you can utilize the "forgot password" option available on the login page. Upon 

selecting this option, a new page will prompt you to enter your user ID. An email will be sent to the email 

address associated with your account, which remains active for a duration of one hour. By clicking on the 

provided reset password link within the email, you will be directed to a page where you can enter a new 

password and confirm it, adhering to the password policy requirements. 

 

 

Otherwise, you can also request your TRECs (Broker)IT offcier to reset your password. 

 

16.2. Device Unregister 

 
It’s need to unregister the device in following cases: 

 Reinstall the DSE-Mobile app; 

 Changing the Mobile device; 

 Cleared the cache for DSE-Mobile App; 

You can unregister the device by following steps:  

1. In login screen, put login Id and Password. Tap on the Connect, it will prompt “Two-Factor 

Authentication” and tap Unregister. 

  Self Service  
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2. An email will send your registered email with the link “Un-register your device”.  This email is 

valid for one hour.  

 

3. Clicking on the link “Un-register your device” from email. A new page will open and type User ID 

and password, click unregister 

  

4. Open the DSE-Mobile and login. 

Otherwise, you can also request your TRECs (Broker) IT offcier to unregister the device. 
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For any technical issue please caontact your TRECs (Broker) IT officer. You may report any to DSE 

through the Facebook page https://web.facebook.com/DSEMobileInvestor/  

 

For any clerifcation on trading funcations, portfolio data and other business terms, please contact your 

trader.  

 

 

  Technical Issues   

https://web.facebook.com/DSEMobileInvestor/

